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Windows XP and Fast Boot/Fast Resume

Customer research has shown that one of the most frequently requested features that users want from their PCs is fast system startup, whether from cold boot or when resuming from standby or hibernation. The Windows development team at Microsoft has taken bold steps in making quickly available PCs a reality with the release of the Windows XP operating system. 

This article provides guidelines for system manufacturers to improve boot and resume times for new PCs. This article also briefly summarizes several of the changes in Windows XP that promote quick system availability.

The design goals for the consumer version of Windows XP on a “typical” consumer desktop are as follows:

· Resume from Standby (S3) in
 ≤ 5 seconds

· Resume from Hibernate (S4) in
 ≤ 20 seconds

· Boot to a useable state in
 ≤ 30 seconds 

Note: High-end PCs with high capacity, multi-platter hard drives, RDRAM, ECC or parity memory, or a far eastern language operating system may take longer. SCSI systems will boot slowly due to expansion ROMs on SCSI adapters and sequentially powering up disk drives.
Microsoft has several OEM notebooks resuming from S3 Standby in less than 2 total seconds. This is approximately the time it takes to fully open the lid of the notebook, delivering a PDA-like experience in availability. Although the Windows XP design goal was 5 seconds, we fully expect OEMs to compete on this with the measure of good equaling the time to open the lid. End-users will shop and make purchase decisions based on this performance similar to other criteria such as battery life, CPU speed, RAM size, and so on.
Boot and resume times are measured from the time the power switch is pressed to the display of the desktop shortcuts.

This paper assumes that the reader has a background in the related OnNow technologies, which are described at http://www.microsoft.com/hwdev/onnow/. 
System power state terminology used in this paper is based on definitions in the Advanced Configuration and Power Interface (ACPI) specification, available at http://www.acpi.info/index.html.

Operating System Boot Improvements

Operating system startup consists of these basic challenges:

1.
Move operating system footprint from the disk drive to memory.
2.
Initialize devices.
3.
Start Winlogon, services, and the shell.
4.
Start value-added software.
Figure 1 shows the major phases of operating system boot in more detail. Time at Zero seconds corresponds to the start of kernel instrumentation shortly after the kernel starts.
Note   The vertical bars for BIOS and NT Loader can not be measured by kernel instrumentation because the kernel is not running at that time. 
Do not attempt to hand time boot and correlate to a boot trace by using the boot done mark + boot loader time + BIOS POST time. The overhead of tracing will skew the results. Start by hand timing, then use a boot trace to view what happened during the hand timed boot.

Figure 1 – Windows XP Boot Activity Summary
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1.
Disk time is the time to enumerate all the devices in the non-page able device path. This is everything from the CPU to the boot disk drive; multiple IDE devices and slow IDE devices can affect this time. Typical disk time in Windows XP is 2 seconds, which is 4 times faster than Windows 2000.
2.
Driver time is the time to initialize devices.

3.
Prefetching time is the time spent reading pages in from disk used later as devices initialize, and Winlogon, services, the shell, and other applications start during boot.

4.
Registry+Page file is time spent to read the registry and initialize the page file.

5.
Video is the time spent as the display mode is set for the final resolution and refresh rate. Video driver and Video BIOS affect this time.
6.
Logon+Services and Shell are the times to start Winlogon, services, the shell, and so on. This is mostly the operating system. However, value added components such as anti-virus software can affect this time.

Windows XP accelerates all portions of operating system boot starting with NT Loader. The most significant changes include the following items:

· Prefetching pages from disk to avoid page faults during boot. As device drivers are loaded, services started, and so on, then pages will be needed from the disk drive. Prefetching these pages means reading ahead before the pages are needed so that they are already in memory thereby eliminating disk I/O delays.

· Device initialization is overlapped where possible and overlapped with Disk I/Os. Windows overlaps the initialization of devices such as serial and network thereby shortening the overall device init time. It is crucially important that device drivers not spin writing/reading registers at 100% CPU since that will lengthen boot.
· De-serialization of the boot process, elimination of processes, deferment of services, footprint reduction. 
· Windows XP has been scrutinized to remove any item from the boot path that does not need to be there. In some cases there were optional items not needed at all, in others services can be deferred to run later after boot. 
· An example of De-serialization is Winlogon no longer waiting for network initialization to complete. 
· Several services are now combined under common processes (Svchost) to reduce the overall number of processes. This reduces memory footprint by approximately 1.5 MB per process eliminated.

Windows XP Support for BIOS Improvements:

Windows XP supports the Simple Boot Flag specification. Implementation of this specification can result in reduced time spent in BIOS self tests if the previous operating system boot was successful. This optimizes the “good boot path” in the BIOS.

For information about the Simple Boot Flag specification, see http://www.microsoft.com/hwdev/resources/specs/simp_bios.asp.
Note   BIOS time on the good boot path should be approximately 7-10 seconds. A PC with a multi-platter hard drive may take as long as 14-15 seconds due to additional mass to spin up in the drive. This includes both BIOS POST and the time taken to spin up the hard drive.
Boot Loader Improvements

A key boost to boot loader performance is through optimizing disk reads. The Windows XP boot loader (NTLDR) caches file and directory metadata in a “most recently used” manner. This dramatically reduces time spent finding data on the hard disk (disk seeks).

Each system file is now read with a single I/O operation. The resulting improvement in Windows XP is that the boot loader is approximately four-to-five times faster than in Windows 2000. If a system is configured for multi-booting both Windows XP and Windows 2000, even the Windows 2000 boot time will benefit from the Windows XP boot loader improvements.
Boot loader enhancements also provide similar improvements in hibernation resume times. The primary reason for this is streamlining the I/O paths used by NTLDR to read the hibernation image. The hibernation file is compressed as it is written and, for efficiency, the compression algorithm overlaps with the file I/O. However, when resuming from hibernation, NTLDR is using the BIOS to perform the Disk I/O; therefore, it is not feasible to overlap the disk I/O reads with the decompression.

Tip   For best hibernation resume times, scrutinize the performance of the BIOS INT13 routine used by the boot loader to read the hibernation file. If resume from S4 is slower than cold boot, look at INT13.
Operating System Boot Improvements

After the boot loader reads the necessary files, the kernel starts. This is the beginning of the operating system starting to run.

Optimizing the time for loading the operating system is achieved by overlapping device initialization with the required disk I/Os, and removing or delaying the loading all other processes and services from boot that are unnecessary at boot time.

In tuning a system for fast booting, it is crucial to look at both the efficiency of device initialization and the disk I/Os.

Overlapping Device Initialization

Windows XP initializes device drivers in parallel to improve boot time where possible. Instead of waiting for each device sequentially, many can now be brought up in parallel. The slowest device has the greatest effect on boot time. Overlapped device initialization can be viewed using the Bootvis.exe tool. (For information about obtaining tools, see “Resources” at the end of this paper.)

In Figure 2, a delay of immediate interest is highlighted in red. The NIC driver is delaying boot, but this PC has no network cable attached to it. This is a good indication to look at the media-sense support in the hardware and driver. The result is the CPU is at 100%, all Disk I/O has stopped, and there is no parallelism in device initialization at that time.

Note   Although the boot activity graph shows prefetching overlapped with the network card delay, it is misleading in the graph. All disk I/O is stalled. This could be seen by looking at the disk activity graph.

Figure 2 - Example of Overlapped Device Initialization and Broken Parallelism due to Net Driver
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Tips   
· Device drivers should only do what is required to initialize the device during boot, and defer all else to post-boot. The goal is that the device is usable after boot, but does not unnecessarily delay boot.

· Device drivers should never spin writing/reading registers at 100% CPU since that will lengthen boot. 
· When taking boot traces, unplug any network cables to avoid external network delays. If unplugged, no entry for network should show in Bootvis that is blocking boot.

Examples of Boot-Time Savings

Several examples of boot time savings include the following:
1.
Network initialization is now done in parallel to boot. Winlogon does not wait for network initialization.
2.
Serial Plug and Play is now overlapped. Serial PNP detects attached serial devices. This used to take 2.5 to 3 seconds for typical PCs, and could take several minutes in large servers with many ports.

3.
Previously, NDIS caused boot delays while binding protocols to adapters, due to the adapter negotiating link speed with hubs and switches. This also affects PCs that have network adapters but no network cables attached. Protocol binding is now done in parallel to boot.

4.
ATAPI boot disk enumeration has been improved to take about two seconds (it previously took approximately 6 seconds). Boot disk enumeration delays all disk I/O during boot. 

5.
Delays to detect PS/2 keyboards on USB keyboard based systems are reduced.

6.
Reduction in processes and grouping of services under common Svchost processes
Prefetching
In versions of Windows earlier than Windows XP, while device drivers, system services and the shell load, the required memory pages will not be in memory until loaded from the disk drive on demand. Another key improvement in Windows XP is prefetching these pages before they are required, which avoids page faults. Page faults delay boot to perform the needed disk I/Os. 
The Windows XP Prefetcher accelerates both boot and application launch. It does this by monitoring the pages required during boot and the pages required after an executable is started. These pages are logged in scenario files in %windir%\prefetch.

On the next application launch or boot, the scenario file is referenced for which pages to prefetch.

Periodically, the scenario files are parsed and a list built in %windir%\layout.ini that defrag will reference to lay these pages out contiguously on disk. Although the pages are prefetched, the disk I/Os used to prefetch them will be more efficient after a disk layout occurs.

Looking at Disk Efficiency with and without Prefetching
Bootvis.exe can be used to view the efficiency gains of prefetching during boot. The goal is to minimize any random seeking that initiates after 2 to 3 seconds into the boot trace, depending on the detection of IDE devices, and continuing for several seconds. The duration of prefetching is dependant on the performance of the disk drive, available memory and anything that might stall a disk I/O. Efficiency in prefetching is important; disk I/O delays could stall the operating system boot.
To disable prefetching for the next boot and take a boot trace with Bootvis.exe, delete the boot prefetch scenario file: %windir%\prefetch\ntosboot-b00dfaad.pf and then take a boot trace.
Prefetching can also be disabled with the following registry key and value:
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\Session Manager\Memory Management\PrefetchParameters EnablePrefetcher set to 0
Figure 3 – Example of Boot with Prefetching
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Note   Overall boot time several seconds faster with prefetching due to fewer seeks. The red bars are reads and blue writes. In this trace, most of the disk reads needed to boot the system are done between 2-7seconds in the graph.
Figure 4 – Example of Boot without Prefetching
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Note   Longer boot time overall, much more seeking. The disk I/O’s are very inefficient.
Looking at Disk Performance
To measure the efficiency of the disk I/O during boot
· Using Bootvis.exe, select a region of the Disk I/O graph by dragging a rectangle or by entering the times in the Select Time boxes on the menu bar.

· Within the selected area, right-click and select Show Summary Table. 
· At the bottom of the summary table is the number for the total of data read in KB during the selection. Dividing the data read within the selection by the time width of the selection gives the data rate per second. Disks can be compared for performance in this manner.
The sector offset graph is displayed by right clicking on the selected area and selecting “Show Detailed Graph”. The detailed graph shows the disk seek patterns within the selection. Figure 4 shows excessive seeking without prefetching, while Figure 3 shows efficient seeking with prefetching due to contiguous page layout.

Boot Monitoring 

Pages accessed during boot are logged in 
%windir%\prefetch\notosboot-B00DFAAD.pf. This file logs the previous 8 boots and is created or updated 1 minute after every boot. This is not idle time dependant. 
The prefetcher uses this file to know which pages to prefetch. The .pf file extension is referred to as a scenario file. Notosboot-B00DFAAD.pf is the boot prefetch scenario file.
Tips   
· In a lab environment, be sure to allow this file to be created or updated before rebooting

· To disable prefetching momentarily, delete this file and no prefetching will occur on the next boot.
Application Launch Monitoring

Pages accessed during application launch are logged in %windir%\prefetch\”appname-xxxxxx”.pf. The prefetcher uses this file to know which pages to prefetch the next time this application is launched. 
Optimizing Disk Layout

Prefetching reads pages into memory ahead of demand based on a learned scenario. It is also important for efficient disk I/O for these pages to be contiguous on the hard disk to eliminate excessive seeking. Prefetching and optimized layout result in reduced page faults and efficient disk I/O’s.
Periodically pages used in boot and application launch are laid out contiguously on disk during idle time. This occurs transparently for end-users but can be confusing in a lab environment if the system is not allowed to idle or meet the other rules for a layout.

The prefetcher service parses both the boot and application launch scenario files, determines what pages to be prefetched, and builds a file named %windir%\prefetch\layout.ini. Layout.ini is used for defrag to lay these pages out contiguously on disk for improved disk I/O.

Layout.ini is built after 32 application starts. It is also built periodically after boots excluding the first boot which runs the out of box experience. Layout.ini is generated and a defrag initiated by the prefetcher service after an idle timeout of approximately 5 to 30 minutes after boot.
Predicting exactly when a system will have optimized itself in the lab is difficult since it requires idle time. If Windows XP is installed, booted two times while allowing for the update of the boot prefetch scenario file, and then allowed to idle, the timeline for the layout would look similar to the following: 
Figure 5 – Disk Layout Timeline (will vary)

	0
	1
	
	1
	2
	3
	4
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	Boot Done
	notosboot-B00DFAAD.pf created
	Boot Done
	notosboot-B00DFAAD.pf updated
	Idle Time
	Layout.ini Created & Defrag


Note timeline observed may vary based on activity
For boot, idle time layout is scheduled using the following criteria:

· Has not been done previously

· Has not been done in the last 3 days

The following registry keys can be monitored for status as well as the timestamps on the layout.ini and boot prefetch scenario files.
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT\CurrentVersion\Prefetcher]
"LastDiskLayoutTime"=hex:30,cb,3d,2b,34,ed,c0,01
"LastDiskLayoutTimeString"="2001/06/04-13:23:08" (should match time on layout.ini)
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Dfrg\BootOptimizeFunction]
"FileTimeStamp"=hex(b):30,cb,3d,2b,34,ed,c0,01
"OptimizeComplete"="Yes" (yes = layout completed successfully)
Boot Optimization vs. Normal Defrag
The Windows XP defrag utility does not undo the boot and application launch optimizations. These files are laid out contiguously on disk with the starting and ending logical block locations logged in the registry. 
A normal file system defrag optimizes the system for application launch or fast boot in addition to defragging the file system. However, it will not optimize for boot of app launch if layout.ini does not yet exist.
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Dfrg\BootOptimizeFunction]
"Enable"="Y" (Y = defrag will optimize for boot and app launch)
"LcnStartLocation"="1396416" (these numbers will vary, do not edit)
"LcnEndLocation"="1443782" (these numbers will vary, do not edit)
Operating System Hibernation Improvements

During hibernation, all devices are powered off, and the system’s physical memory is written to disk in the system hibernation file, \Hiberfil.sys. Before Windows XP writes to the hibernation file, all memory pages on the zero, free, and standby lists are freed; these pages do not need to be written to disk. Memory pages are also compressed before being written. 

To optimize the hibernation process in Windows XP, the following improvements have been implemented.

· The compression algorithm has been optimized to compress and decompress large blocks (64K) of data.

· The hibernation file is written using IDE DMA instead of PIO mode. Most modern IDE controllers and disks achieve their best performance only in DMA mode.

· As the current data block is being transferred to the disk, the next block of data is being compressed. Overlapping the compression with disk writes makes the compression time virtually free.

Operating System Standby Resume Improvements

During resume from standby, the operating system sends S0 IRPs to devices to indicate the change in system power state. Device drivers then typically request D0 IRPs to change their device power state. The operating system is responsible for notifying each device in the correct order. There are two key ordering rules that must be followed to prevent deadlocks:

· A device cannot be turned on until its parent is turned on.

· All non-paged devices must be turned on before any paged device is turned on. 

Because many devices may take significant time to go from D3 to D0 state, the key to good resume performance is to overlap device initialization as much as possible. Therefore, the ordering chosen by the operating system is important in maximizing parallelism.

The following changes have been made to optimize the resume performance in Windows XP.

· The Sx IRP dispatching engine has been rewritten to maximize potential parallelism.

· USER has been changed to dispatch power events asynchronously instead of tying up a worker thread waiting for them to complete.

· Ndis.sys has been changed to complete S0 IRPs immediately (instead of waiting for D0 to complete) and to initialize on a lower priority thread.

· Worker thread stacks are locked in memory before starting power operations, and unlocked when resume is complete.

· The kernel Plug and Play manager has been changed so it does not tie up a worker thread with an enumerate operation while waiting for power operations to complete.

· Pcmcia.sys, Kbdclass.sys, and Mouclass.sys have been changed to initialize in the background. 
Measuring Boot Time 

From an end-user perspective, what is important to measure is the time from the moment the power switch is depressed to the time the desktop accepts user input.

In order to correlate more meaningful numbers with the Windows product team, cold boot time is divided into three phases: 

1.
BIOS POST. The time for the POST to run and spin up the hard disk drive and for the reading of the operating system boot loader.  This ends with the display of the boot menu in the boot loader.
2.
Pre-Logon. The time from the boot menu to the Windows Logon screen. 

3.
Post-Logon. The time from clicking on an account in the Logon screen to the Windows Desktop. This measurement is helpful in assessing delays introduced by items in the Startup group, Run key, and so on.

To measure boot time
1.
Follow the “Preparing System for Fastboot” instructions later in this document.
After completing step 1, the system is ready for hand timing or tracing.
2.
Time from pressing the power switch to the display of the boot menu from the boot loader. Log this time as POST.

3.
Time from the boot menu to the display of the welcome logon screen user accounts. Log this time as Pre-Log.

4.
Time from clicking on a user account to the display of the desktop icons. Log this time as Post-Log.

5.
The sum of the times from steps 2–4 is the total boot time.

In working with the Windows product team, it is important to report all three numbers. Wherever a problem is suspected due to resulting times, use the Bootvis.exe tool to get a trace of boot. When taking traces, ensure the system auto-logs on by deleting any extra user accounts. There should be only one user account in addition to the guest account for auto-logon to occur.
Because the number of platters in a disk drive, the memory type, and other factors effect POST time, it helps to isolate these factors away from operating system time by breaking into three numbers. Driver issues tend to show in the pre-log number. Value added software issues normally show during post-log.
Tips   
· Use a single disk partition. 

· Use NTFS on hard disk drives. The FAT on FAT32 file systems get large on partitions larger than 8 GB because the whole FAT is read during boot.
· Do not convert FAT32 to NTFS unless you are using the OPK tools. If doing an install from a retail CD, delete any FAT partitions and build NTFS; do not convert.
· Be sure to allow the disk to fully spin down between measurements. A delay of 20secs is recommended before booting again.
· Make sure you have fully booted the operating system and performed a typical shutdown before timing POST on a system where the BIOS implements the Simple Boot Flag specification. The BIOS implementation of the Simple Boot Flag specification may interpret a shut down from the boot menu as a failed boot, affecting subsequent BIOS POST timing. 

· To avoid external network boot delays, unplug network cables. If boot times increase when cables are unplugged, look at the media-sense support in the network adapter and its driver.
Preparing System for Fast Boot
Because the disk optimizations occur after idle timeouts, it is easy in a lab to install Windows and not let the correct events occur, which leads to inconsistent timings and invalid data. To solve this, Bootvis.exe now supports an Optimize System option to force all these events to occur. 
To prepare a system for boot timings or tracing
1.
Use a single NTFS partition. (Do not convert from FAT32 to NTFS unless using OPK tools for conversion).
2.
Build pre-load or install Windows.
3.
Boot, complete OOBE.
4.
Configure internet connection.
5.
Activate Windows if Windows was installed from a retail CD.
6.
Enable 2 user accounts either in OOBE or in the user accounts control panel (in addition to the guest account).
7.
Cancel Windows XP Tour when it pops up.
8.
Cancel Passport Configuration when it pops up (after next boot).
9.
Finalize all settings.
10.
Enable a boot menu in Boot.ini.
11.
Start Bootvis.
12.
Select Optimize System in the Trace Menu (this will take approximately 5 minutes to complete and will reboot once).
13.
Take hand timings or traces.
Factors Effecting Boot Time
There are several tips lists at the end of this document for improving boot time.
The biggest influencers in achieving a fast boot time are to have enough RAM and a fast disk drive.

1.
In order to prefetch, there needs to be sufficient RAM to prefetch into. 64 MB systems will suffer due to insufficient RAM reducing Windows XP’s prefetching benefits. 128 MB is a much better scenario. More than 128 MB helps performance overall but boot performance gains are minimal after 128 MB.
The best improvement for 64 MB systems is to add another 64 MB.

2.
Although prefetching helps, the operating system image has to move from the disk to memory. The faster the bits come off the heads of the disk drive and into memory, the faster boot will be. Moving from a 5400 RPM disk to a 7200 RPM disk can save several seconds in boot time. Larger buffers on disk drives can also help.

Note   When comparing disk speeds, make sure to compare disks with the same number of platters for a direct comparison of spindle speed effects.
3.
CPU performance has little effect in the first half of boot but does help in the Winlogon phase of boot if the CPU is faster. CPU is often at 100% utilization in this portion of boot.

4.
Use the Bootvis.exe tool if your hand timings seem to be too long. Bootvis.exe will expose areas that warrant deeper investigation. Most commonly these are in device drivers. 
5.
Value added software can also slow boot. Bootvis.exe will show you the start of these processes, the CPU load, the disk I/O’s caused by them. Evaluate the software you bundle for good boot time.

Note   The Windows XP prefetcher stops monitoring boot 10secs after the start of the explorer process so the software you add to boot is likely to be loaded faster due to prefetching.
Figure 6 shows the effects on boot time as the hard drive motor speed and memory configurations are varied. It is important to note that 128 MB with 5400 RPM is a better overall experience than a small memory configuration with a faster disk. Small memory means more paging and even with a fast disk that is not a great experience. Therefore choose more ram before a fast disk and always start with 128 MB minimum for a reasonable end user experience.
Figure 6 – Effects of Disk Speed and Memory on Boot Time
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Note   These numbers taken on Dell Dimension model 4100 with Windows XP Home Edition build #2458.
For a fair comparison, make sure when comparing disk speeds that both disks have the same number of platters.
Far eastern languages also are longer to boot since there are three additional processes that must be loaded to handle the far eastern input methods. This can be as little as 1.5 seconds on a fast disk with 128 MB to several seconds on slower disks or memory constrained systems.

The worst configuration for performance is a notebook (4200 RPM disk), 64 MB and a far eastern language such as Japanese and a lot of value added software being started in boot. This machine will boot very slow and also respond very slowly after booting. If placed next to a 128 MB system of the same configuration, the 128 MB machine will be noticeably faster.

Windows XP Fast Boot/Fast Resume Tools 

Windows XP has the ability to trace boot and resume metrics and dump the resulting information to a binary file for viewing and analysis. 

Bootvis.exe displays several time-interlocked graphs showing CPU Usage, Disk I/O, and Driver Delays, Boot Activity overall, Process Starts, and Resume Activity. 

The traces that can be taken using Bootvis.exe are:

· Next Boot

· Next Boot with Driver Delays

· Next Standby/Resume

· Next Hibernate/Resume

Bootvis.exe can show many types of useful details, so the best way to start is by dragging an area on the graph and then either double-clicking it or right-clicking to view the options available on a context menu.

Overall boot activity is shown in the Boot Activity graph in Figure 7. 
IMPORTANT   The Bootvis tool is provided to help you develop a general idea of where there may be issues or problems with boot or resume. They graphs may provide information that will help identify where to use more specific development tools. Bootvis.exe will not specify the exact fixes that need to be made; it should only be used as a tool to help locate or identify potential problem areas. 
Figure 7 – Boot Activity Graph
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The boot activity graph shows BIOS and NT Loader bars as place holders prior to the start of the boot trace. Times are offset from BIOS and NT Loader indicating the need to add BIOS+NTLoader to any boot timings being taken.

The boot activity graph clearly shows the overlap of prefetching and device initialization. Remember to look in more depth at the prefetching disk I/Os to check for sequential I/O and note the disk throughput by viewing the summary table for this time window.

The boot activity graph shows a mark for boot done. This corresponds to the Start Menu being available for use.

Taking boot traces with Driver Delays will lengthen boot by 2 to 5 seconds. The resulting binary file will be several megabytes in size.

Bootvis.exe has the ability to loop, taking the number of traces specified and storing them in files automatically incrementing the file name. This is very convenient in taking a batch of timings. In taking boot timings, it is a good practice to take 5 timings per configuration to ensure there are no unusual deviations. If the repetition option in Bootvis.exe is used, there is an option for shutdown or restart. If shutdown is chosen, the system will be turned off between boots such that a hand timing can be taken capturing the BIOS POST and NTLoader times to correlate to the boot trace.

Using Bootvis.exe

To use Bootvis.exe

1.
Create a directory named Ptools. Copy Bootvis.exe to Ptools. 

2.
Start Bootvis.exe.

3.
From the Trace Menu, the following traces are available:

· Next Boot 

· Next Boot with Driver Delays 

· Next Standby/Resume 

· Next Hibernate/Resume 

Note   Tracing Driver Delays during boot will add several seconds of boot time delay.

4.
Select the desired trace Bootvis will prompt with a couple questions for file naming and looping and reboot the system to take the trace.

5.
You have the option of setting a repetition count if taking multiple traces. The file name will be named after the trace type with an incrementing number on the end of the file for each trace.

6.
Bootvis_sleep will be created in the folder containing Bootvis.exe. This is a small stub used to start bootivs.exe after a delay after boot to keep Bootvis.exe from effecting the trace. Bootvis.exe is a large MFC application. 

7.
Bootvis.exe will restart and save the trace to the last folder used by Bootvis.exe. It will then open and display the trace.

CPU Usage Graph

The top-level CPU usage graph shows the percentage of time the CPU is busy over time. 

Drill downs:

· A summary table shows a breakdown of the time spent in each process during the selected time. 

· Double-clicking a process line in the summary table will display a table that breaks the time within a process by module. 

Disk I/O Graph

The top-level disk I/O graph shows the number of reads and writes recorded for each second of the trace. 

Drill downs:

· A summary table shows the breakdown of I/Os by file for the selected time region. 

· A Details Graph shows the sequence of I/Os and illustrates disk seeks between I/Os. 

Detailed Disk I/O Graph

This graph allows the examination of the I/O pattern for a particular disk. By default, I/O completion times are charted, but optionally I/O initiation times can be charted as well. The I/Os for each process can be included or excluded by selecting the process from the panel on the left. Marks within the trace can optionally be displayed.

Drill downs:

· A Summary chart shows the logged information for the selected I/Os.

Driver Delays Graph
This display shows all calls into drivers that return after exceeding a particular delay threshold, specified when the trace was created. The delays are labeled with the name of the driver within which the delay occurred. Note that this driver can be recursive, so a long delay in one driver may produce a long delay in calling drivers. 

A time range can be selected. In addition, by right-clicking to display a context menu, the user can select an individual delay or all delays in the entire trace for the same driver. 

Drill downs:

· A Summary chart displays the delays experienced for the selected time region or driver.

Process Creates Graph

This display shows the start of processes, beginning with Explorer.exe. This information can be useful when looking at the pre-load and analyzing the effect of software added beyond an operating system clean install.

The prefetcher attempts to optimize boot speed by monitoring files accessed during boot, ending 10 seconds after the start of Explorer.exe. If the added software is large, the optimizations gained by using prefetching will diminish late in boot.

Using Bootvis.exe to Measure Resume Performance

When evaluating a system’s resume-from-sleep (S3) performance, key elements to observe are the BIOS wake time and the delays introduced by device drivers during initialization. Bootvis.exe opens resume traces with initial views that display this important data. 
Measuring Resume from Standby (S3)

The following steps describe how to measure system resume times from standby (S3).
1.
Start Bootvis.exe

Tip   For the purpose of measuring the best resume performance, turn off "Prompt for password when computer resumes from standby" from Control Panel‑>Power Options‑>Advanced. 

2.
From the Trace menu, choose Next Standby & Resume.

3.
Select the number of trace repetitions to run. Enter the desired number of repetitions; selecting OK will use the default setting of 1 standby trace.

4.
The countdown timer indicates the time remaining until system shutdown. You may shutdown immediately by clicking the Standby Now button, or stop the trace by clicking Cancel. 

Note   The Shutdown Time and Sleep Time periods can be configured using the Options dialog box. To access this dialog, from the Tools menu, choose Options, or press the Alt-F7 accelerator key combination.

5.
The system will awaken automatically after the Sleep Time period has elapsed.

6.
After the system resumes from Standby, Bootvis.exe will automatically open and display the resume trace file, as shown in Figure 8.

Figure 8. Bootvis.exe Resume Trace
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Note   If you have selected to collect multiple traces Bootvis.exe will not automatically open the resume trace file when the last trace is complete. Use the File menu to open the desired trace file for viewing.

Resume Activity Window

The top level Resume Activity window displays a graphical summary view of the resume trace. 
Figure 9: Top Level Resume Activity Window
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Drill downs:

· The vertical marker lines indicate the various phases of the resume process. Placing the mouse cursor over the square boxes at the top of the marker lines will present a tool tip with additional information.

· The green horizontal graph bars graphically illustrate the resume phases in time. Placing the mouse cursor over the graph bars will present a tool tip with the bar title and time elapsed.

Resume Summary Window

The Resume Summary window displays a tabular summary of the resume trace information. Refer to Figure 10. To display the Resume Summary window, select Show Resume from the Tools menu, use the Ctrl-R accelerator key combination, or right click in the Resume Activity window to display the context menu.

Drill downs:

· The following summary information is displayed: 
· BIOS wake time
· Device initialization time
· Application initialization time
· Total resume time

· A tabular view lists those device drivers taking longer than the Driver Delay Threshold to complete their S0 IRPs.

Note   The Driver Delay Threshold time is specified in the Options dialog box.

· Clicking on the Save Table button will export this summary date in either .CSV or .TXT file formats for use with other application software.

Figure 10: Resume Summary Window
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Driver Delay Window

The Driver Delay window displays a graphical depiction of device drivers as they are sent system power IRPs (Sx and Dx) versus time. Refer to Figure 11.

Figure 11: Driver Delay Window
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Drill downs:

1.
The green horizontal graph bars show device drivers taking longer than the Driver Delay Threshold to complete their S0 IRPs.

Note   The Driver Delay Threshold time is specified in the Options dialog box.

2.
The Driver Delay window is initially displayed with Device (Dx) IRPs hidden. To display Device IRPs, right click on the driver delay window to bring up the context menu, and click on Show Device IRPs.

3.
Placing the mouse cursor above a driver delay bar will display a tooltip with further information about the driver.

4.
Double-clicking on a driver delay bar will open a tabular summary window of information about the driver.

Measuring Resume from Hibernation (S4) Time

From an end-user perspective, what is important to measure is the time from the moment the power switch is pressed to the time the desktop accepts user input.

Hibernation resume time is divided into two phases: 

· BIOS POST — the time needed for the POST to run and spin up the hard disk drive, and the time needed to read the operating system hibernation file. 

· Device Initialization — the time needed for devices to process system power notifications and restore their context.
The sum of these two phases is the total hibernation resume time for a PC.

To measure hibernation resume time:

1.
Start Bootvis.exe

2.
From the Trace menu, choose Next Hibernate & Resume.

3.
Select the number of trace repetitions to run. Enter the desired number of repetitions; selecting OK will use the default setting of 1 hibernate trace.

4.
The countdown timer indicates the time remaining until system shutdown. You may shutdown immediately by clicking the Hibernate Now button, or stop the trace by clicking on Cancel. 

Note   The Shutdown Time period can be configured using the Options dialog box. To access this dialog, select Tools > Options, or press the Alt+F7 accelerator key combination.

5.
Windows will write the hibernation file and shut down.

Note   Use a stopwatch to complete the next step.

6.
Measure the time from pressing the power switch to the completion of the “Resuming Windows” screen; this provides a close measure of BIOS POST and hibernation file read time.

7.
After the system resumes from Hibernate, Bootvis.exe will automatically open and display the hibernate resume trace file, as shown in Figure 12.

8.
Hibernation resume time is the total of the BIOS POST and hibernation file read time measured in step 6 above, plus the Device Initialization time shown in Bootvis.exe.
Figure 12: Resume Trace Display 
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Actions for Achieving Fast Boot/Fast Resume

The following areas should be considered for designing systems to support fast startup for systems that run the Windows XP operating system.

Actions for BIOS Fast Boot Improvements

· Implement support for the Simple Boot Flag in the system BIOS. Reduce all possible delays in POST if the last boot is known to be good.

· Set hard drive first in the boot order in a good boot path. CD-ROM or floppy drives are more meaningful in the boot path if the last boot failed. On systems with CD-ROM boot order set as first on normal boot, if media is in the tray, the CD-ROM must be spun up to see if the CD drive is bootable. This can delay boot by several seconds when media is in the tray—which is a common end-user scenario.

· If drive lock is not enabled, don’t check the disk. Drive lock is used to secure the content of disks such that they cannot be removed from one PC and accessed on another for security purposes.

· Windows does not expect memory to have been cleared. BIOS POST does not need to clear memory on systems without hardware requirements such as ECC, Parity, or RDRAM. 

· Optimize system BIOS logo splash screens or eliminate them. This includes optimizing the display time, the size of display coming out of ROM, and the time to decompress before displaying the screen.

· Remove advertisements from expansion ROMs. The video BIOS often includes such advertisements.
· If the PC does not support IDE expansion past a single hard drive and CD/DVD drive, configure the BIOS to not look for other devices on the primary and secondary IDE channels.

· For the Windows XP operating system, there is no need to restore drive timing on secondary IDE channels.

· For systems implementing PXE boot, do not run POST on a network adapter ROM if the user did not initiate a PXE boot.

Actions for BIOS Wake Improvements

· On mobile systems, send IDE power-on and reset commands as soon as possible in the BIOS resume path to start disk spin up early.
· Make sure the BIOS applies the latest processor microcode update, if one exists.  This will reduce or eliminate time spent by a processor update driver during the device initialization phase of resume.
· Do not configure IDE drives in BIOS; use the _GTF method in your ASL code.
· Only initialize devices required to hand off to the operating system.
· Do not enumerate the USB bus
· Do not save and restore the entire PCI configuration space.

· Do not touch PS/2 devices, only enable the ports.

· Work with your BIOS developers or vendors to reduce BIOS WAKE times to 500mS or less.

· Your S3 resume path should not look like the APM resume path.

· If S4 resume is slow, optimize the INT13 performance in the BIOS. BIOS INT13 calls are used during resume from S4 for the disk I/Os that read the hiberfile. 
Actions for Driver Fast Boot/Fast Resume Improvements

· Device drivers should only do what is required to initialize the device during boot and defer all else to after boot is complete. The goal is that the device is usable after boot without unnecessarily delaying boot.
· Drivers should use high-priority worker threads and critical queue work items if they are on the critical path of resume and have to do a small task. Otherwise, they will be starved for CPI by unrelated threads and the system won't resume quickly.
· Functional device drivers should complete S0 IRPs immediately, then request a D0 IRP. This allows the system to complete resuming while your driver performs device-specific re-initialization in the background.

· Device drivers should never hold spin locks except for very short durations, especially during boot, because this defeats any efforts toward parallel device initialization.

· Use Bootvis.exe to examine the resulting effect on overlapped driver initialization and disk I/O when developing a new device driver.

· Use Bootvis.exe to identify and correct any device drivers that don’t complete S0 IRPs quickly, or otherwise block the system from continuing on the resume path.

Actions for OEM Pre-load Fast Boot Improvements

Having several programs loading at boot will slow down boot times. 

· Use as much built-in Windows functionality as possible.

· Avoid adding extra schedulers to the system. Use the scheduler built into Windows for reminders, anti-virus programs, scheduled anti-virus pattern file updates, and so on.

· Use standard HID key mappings on your keyboards. Adding an extra keyboard filter driver can slow boot. Windows XP has built-in support for a large variety of “special” keyboard buttons for launching web browsers, volume control, CD controls, and so on.

· Leverage Windows XP PC-Health support services such as Auto-update, Help Center, System Restore, and Assisted Support.

· If you need to load other functionality at startup, consider delay loading rather than loading everything when the system starts. Only load what is critical for the end user.

· Use a single NTFS partition when building hard disk images. 

· NTFS is more efficient in boot for disks larger than 8 GB. FAT reads the entire FAT during boot. NTFS reads only required metadata.

· Optimize OEM branded wallpapers. If you don’t need the color depth, reduce it and stretch where possible.

Hardware Fast Boot/Fast Resume Improvements

· Ship 128 MB of memory at a minimum

· Typically, a faster disk means a faster boot. 
· Use Bootvis.exe in the hardware qualification process in your company to compare hardware and to identify boot and resume delays. Work with your development team or your suppliers to understand and eliminate these delays. This applies to devices in the PC and devices connected to it, such as the keyboard, mice, hubs, and so on.

Resources

Related tools and information about optimizing for fast system startup on PCs running Windows XP can be found at: 
http://www.microsoft.com/hwdev/onnow/ 
For questions, please send e‑mail to OnNow@microsoft.com. Please be sure to include your name, title, company name, company type (IHV, ISV, ISP, or OEM), and phone number. 

When sending data or reporting issues, please include the build number of Windows XP you are using and explicit details about the hardware configuration.
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